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Take your presentations from good to great. Create presentations quickly and easily with more 

engaging results. Microsoft® PowerPoint® 2010 delivers the tools you need to turn basic slides 

into dynamic, creative masterpieces that help your ideas stand out from the crowd. 

Designed to meet your evolving needs and the way you work, PowerPoint 2010 makes it easy to 

create captivating, professional-quality presentations.  

¶ New video toolsñalong with an array of new and improved features such as transitions, 

animations, and advanced picture editingñenable you to tell a crisp, cinematic story 

thatõs as easy to create as it is powerful to watch.  

¶ Tools to simplify and streamline your work help you get things done more easily whether 

youõre working on your own or with others. 

¶ New technologies give you the freedom to work when and where you choose.  

PowerPoint 2010 helps you deliver impressive presentations and gives you faster, more flexible 

ways to create them. 
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Whether you need a few slides to share with colleagues, classmates or friends, or an award-

winning presentation, you want your  ideas to jump off the screen.  Fortunately, PowerPoint 2010 

delivers the features you need to create great-looking, dynamic presentations that help you 

captivate your audience and express yourself effectively. 

Make the media fit the message  

New and improved, easy-to-use tools give you the power to customize the media in your 

presentations for professional-quality results every time. 

¶ Embed and edit videos from within PowerPoint. Now you can edit video s like a proñ

add fades, formatting effects, bookmark scenes, and trim videos to personalize your 

presentation for the perfect multimedia experience. And since the embedded videos 

become part of your PowerPoint presentation, you donõt have to manage additional files 

when sharing with others. 

¶ Reduce file size and improve the playback experience using the new Compress Media  

and Optimize Media Compatibility  tools for the embedded video and audio files in 

your presentation. 

¶ Use new and improved picture editing  toolsñincluding professional-quality artistic 

effects, background removal, and advanced correction, color and cropping toolsñand 

fine-tune the pictures in your presentations without the need for additional photo -

editing programs.  

Create extraordinary presentations  

Design, layout, graphics, and effects all work together to help you communicate your ideas. Not 

a professional designer? No problemñyouõre just a few clicks away from slides that help 

maximize the impact of your message. 
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¶ Add dynamic 3-D slide  transitions  and more realistic animation  effects to grab your 

audienceõs attention. You can also use the new Animation Painter  to copy your custom 

animations as easily as you use Format Painter to copy formatting of text and objects. 

¶ Take advantage of more professionally-designed, customizable Office themes  to quickly 

create beautiful presentations. You can also use themes to easily coordinate colors, fonts, 

and graphic formatting effects throughout all of your Microsoft Office 2010 documents 

for a polished, professional statement. 

¶ Explore a wide selection of additional SmartArt graphics ñincluding many new layouts 

for organization charts and picture diagramsñand use improved tools to create 

inspiring, engaging graphics just by typing a bulleted list.  

Get easier access to  the right tools, at the right time  

New and improved features can help you create better content and work more easily, but only if 

you can find those features when you need them. Fortunately, the enhanced, customizable 

Ribbon  in PowerPoint 2010 makes it easy to uncover more commands so you can focus on the 

end product, not how to get there.  

Want an easier time making sure that your presentation is finished and ready to share? Wishing 

for a faster, more direct way to print something? The new Microsoft Office BackstageË view 

can help you achieve all of this and more. You can now more easily print, share, and manage 

presentations and their content, and customize your PowerPoint 2010 experience, all from one 

convenient location. 

Save time and simplify your  work  

Itõs much easier to create and manage presentations when you can work the way you want. 

¶ View and edit multiple presentations independently, side -by-side, or even on separate 

monitors  with new multi -window support . 

¶ Organize, access and assign slides with ease using new presentation sections . 

¶ Recover files  that you closed without saving ! Thatõs right. You can now recover 

presentations that you accidentally close without saving, even if you had never saved the 

file. 
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¶ Save time and improve results with the intuitive new Paste with Live Preview . Getting it 

right the first time is always faster than doing it over.  

You may share presentations with colleagues or friends, or work together with others on a team 

project. Regardless, the complications and delays that can arise when sharing or collaborating 

on content can be frustrating to say the least. That is, until now. PowerPoint 2010 makes waiting 

your turn a thing of the past and gives you ne w and improved tools that make sharing your 

work simple and hassle-free. 

Redefine working together on presentations  

PowerPoint 2010 provides easy ways to bring people together. New and improved technologies 

help break down barriers so you can share and work together more efficiently and effectively. 

¶ Broadcast your slide show  instantly to people in other locations, whether or not they 

have PowerPoint installed.1 Or, create a video  of your presentation ñincluding your 

transitions, animations, narration, and timingsñto share with virtually anyone, any time. 

¶ You can now edit the same presentation , at the same time, as other people in other 

locations. 2 You can even communicate instantly  as you work, directly from 

PowerPoint.3  

¶ Collaborate with confidence using new, improved and simplified security tools. For 

example, the new Protected View  helps you make informed decisions when opening 

unknown files, before exposing your computer to possible vulnerabilities.  

¶ Break down language barriers with new and  improved translation tools  and language 

settings . 

                                                 

1
 Requires Microsoft SharePoint Foundation 2010 (for business) or a free Windows LiveË ID (for personal use). To broadcast via 

SharePoint 2010, Microsoft Office Web Apps must be installed. Broadcasting via Windows Live is a free service that enables up to 50 

attendees per broadcast. 

2
 Requires Microsoft SharePoint Foundation 2010 (for business) or a free Windows LiveË ID (for personal use).  

3
 Instant messaging requires one of the following: Microsoft Office Communications Server 2007 R2 with Microsoft Office 

Communicator 2007 R2; Windows Live Messenger, or another instant messaging application that supports IMessenger. Voice calls 

require Office Communications Server 2007 R2 with Office Communicator 2007 R2 or an instant messaging application that supports 

IMessengerAdvanced. 
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Ideas, deadlines, and work emergencies donõt always occur conveniently when you are at your 

desk. Fortunately, PowerPoint 2010 gives you the power to get things done when and where 

you want. 

Work when and where you choose  

Itõs easy to take your PowerPoint 2010 presentations with you and stay on top of your work 

when youõre on the go. 

¶ Microsoft PowerPoint  Web App  enables you to view a high fidelity version of your 

presentations, make light edits, or view your presentation slide show. Access some of the 

same formatting and editing tools that are in PowerPoint 2010, and work in a familiar 

editing environment, from almost any computer with a Web browser. 4 

¶ Micros oft PowerPoint  Mobile 2010  gives you a lightweight editor for your 

presentations thatõs especially designed for easy use on your Windows phone. You can 

even run your slide show right on your phone. 5 

                                                 

4
 Office Web Apps require an appropriate device, Internet connection, supported Internet Explorer, Firefox, or Safari browser, and 

either SharePoint Foundation 2010 for business or a free Windows Live ID for personal use. There are some differences between the 

features of Office Web Apps and the Office 2010 applications. 

5
 An appropriate device is required. Some mobile functionality requires an Internet connection. Office Mobile 2010 is not inclu ded in 

Office 2010 applications, suites, or Office Web Apps. It will be available at the general availability of Office 2010 on Windows phones 

(Windows Mobile 6.5 or above). There are some differences between the features of Office Mobile 2010 and the Office 2010 

applications. 
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Make the media fit the message  

Embed, Edit and Format Video  New!  

Embed video and customize your video experience right in PowerPoint 2010, without the need 

for additional software. When you insert videos from your files, they are now embedded by 

default so you donõt have to manage additional files when sharing with others. 

Easily edit and manage the videos you insert from your files : 

¶ Video bookmarks . Bookmark key points in your video for quick access or trigger 

animations to start automatically when a boo kmark is reached during playback. 

¶ Video trim . Trim your embedded video with a simple click and drag, so that your 

audience sees exactly what you want. 

 

Figure 1: Trim video directly from within PowerPoint 2010. 
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¶ Video tools . Add fades, video effects and styles. The formatting and effects that you 

apply to the videos you insert from your files are retained while the video plays. 

¶ Video p oster frame . Use your slide area to tell your story more effectively and avoid 

solid black rectangles that are difficult to print. Select a frame from the video or a picture 

from your files as an image that fills the object area when the video is not playing.  

 

Figure 2: Apply formatting and effects to your videos from the Video Tools Format tab. Find 

features including bookmarks, fade and trim on the Video Tools Playback tab.   

¶ Play video as background:  Place video objects behind placeholders or other content on 

the slide master or slide layouts, or on a slide behind other objects. Videos that you 

insert from your files remain in the order you place them, giving you the ability to 

playback video as a dynamic slide background or as part of a choreographed animation 

sequence during your presentation. 

Quick Tips:  

¶ When you embed video and audio files in your presentations, you embed a copy of that file. So all 

formatting and editing that you do to the media object on your slide affects only the copy of that 

object that resides in your presentationñthe original media file is not changed.  

¶ You can also edit the embedded audio files in your presentations. Trim, add fades and insert 

bookmarks to key points. 

¶ Need to insert video or audio from your files as a link instead of embedding the file? In the Insert 

Video  or Insert Audio dialog box, select the media file you want to insert , click the arrow beside the 

Insert  button , and then click Link to File . When you insert video or audio as links, you can still use the 

editing and formatting tools to customize the media on your slide without affecting the original file.  

¶ PowerPoint 2010 offers more media format flexibility. Insert a core set of audio and video formats, 

such as WMV, WMA, and MP3. Core formats supported out-of-box will vary with operating system. 

PowerPoint 2010 also supports additional formats, such as DivX, MOV, and H. 264 when you install 

DirectShow codecs available from third parties (fees may apply). 
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¶ Compress Media : Embedding video and audio files in your presentations helps you 

create powerful, dynamic slide shows. But embedding those media files can also add 

substantially to file size, making presentations more difficult to share. And very large 

media files can require more system resources for high playback quality.  

 

With these issues in mind, PowerPoint 2010 provides the Compress Media  tool to help 

you reduce file size and improve performance. Just click to select the compression 

quality you prefer, as shown in Figure 3. If you are not happy with the quality when you 

playback your media after compression, it takes just one more click to undo the last 

compression. 

¶ Optimize Media Compatibility : Need to run your slide show on another computer or 

send it to others to p lay on their own? The Optimize Media Compatibility tool adapts the 

encoding of your embedded media files to help improve the playback experience when 

your presentation runs on another computer.  

 

Figure 3: Access 

media 

compression and 

opti mization 

options in 

Backstage view, 

on the Info tab.  

Quick Tip:  For more information about how features such as video trim and compress media work with 

your embedded media files, see the Power User Tips section of this guide. 
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Insert V ideo from Web Site  New!  

Easily insert linked videos that youõve uploaded to Web sites for playback directly in your 

presentation.6 

Just copy the embed code text that you see on the Web page where your video is posted and 

paste it into the dialog box shown in Figure 4. PowerPoint inserts the video on your slide so that 

you can play it without leaving PowerPoint during your presentation.  

 

Figure 4: Just copy and paste embed code text to insert videos that you have 

posted on the Web onto your slides. 

Video and Audio C ontrols  New!  

Pause, rewind, fast-forward, move to bookmarks, and change audio volume while presenting. 

These new controls enable you to manage playback for the video and audio on your slides 

without leaving slide show mode. 

                                                 

6
 Internet connection required for playbac k of linked video from a Web site location.  
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Figure 5: Just 

point to a video 

or audio object 

during your 

slide show to 

see and access 

controls. 

Quick Tip s:  

¶ You might already know that you can press the F1 key while in slide show mode to view a list of 

common keyboard shortcuts for use while presenting. PowerPoint 2010 adds many new shortcuts, 

such as those for media controls as you see here. 

 

¶ The new audio and video controls are available to media that you insert from your files. Videos that 

you insert from a Web site will have the controls as provided by that Web site. 
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Picture Editing Tools  New and Improved!  

PowerPoint 2010 gives you the freedom to be your own graphic artist with a range of new and 

improved tools for working with images.  

¶ Apply all new Artistic Effects, such as paint strokes, line drawing, glass, pencil sketch, and 

pastels. 

¶ Explore new correction tools, including Sharpen and Soften, as well as improved 

Brightness and Contrast tools. 

¶ Experiment with new color tools, including Color Saturation  and Color Tone, and an 

improved Recolor tool.  

¶ Grab only what you want from your image and leave the rest behind with a new Remove 

Background tool. 

 

Figure 6: Original image shown at top and then clockwise using the glow edges, cutout, and 

glass artistic effects, and with image background elements removed. Color and correction 

tools help turn the same image into the slide background. Additionally, picture styles and 

effects are applied here to add border, shadow, bevel, rotation, soft edges and shapes. 
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¶ Perfect your pictures quickly with an advanced cropping tool that enables you to pan 

and zoom in on your image to always show exactly what you want your audience to see. 

 

Figure 7: Advanced 

cropping 

functionality 

displays your full 

image in shadow 

while you crop and 

includes the ability 

to crop to a shape 

(as shown here) or 

to crop to a 

specified aspect 

ratio. 

Quick Tip:  Use Live Preview to save time when editing photos. Point to an option in the Correction , 

Color , or Artistic Effects  galleries to see the settings applied to your selected picture. And, if you donõt 

see exactly what you want in the galleries, find an Options  command at the bottom of any of those 

galleries for a dialog box that offers advanced formatting choices. 

Note : The same new and improved picture editing tools are also available in Microsoft Word 

2010, Microsoft Excel®  2010, and Microsoft Outlook ®  2010.  

Insert Screenshot  New!  

Want even more ways to add the impact of images to your presentations? Take screenshots in 

your other open windows  directly from PowerPoint 2010. Or, select from a gallery of available 

screenshots automatically populated by your open windows. 

Note : The ability to take screenshots directly from Office 2010 programs is also available in 

Word, Excel, Outlook, Microsoft Publisher and Microsoft OneNote® . 
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Create extraordinary presentations  

Slide Transitions Improved!  

Slide transitions can help your presentations look more polished, flow more smoothly, and 

emphasize key talking points. With PowerPoint 2010, you can captivate your audiences with new 

and improved slide transitions, including high -quality 3-D transitions that rival the type of 

graphic effects that you see on TV.  

 

Figure 8: The Gallery slide transition shown here is one of many new 3-D effects 

available for your presentations. 

Choose from an array of new and improved transition effects using the new Transitions tab with 

a more intuitive transitions gallery and options for many effects, as shown in Figure 9. 
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Figure 9: The new Transitions tab in PowerPoint 2010. Select a transition from the 

gallery, as shown here, and then select from a range of effect options that vary by 

transition. 

Quick Tip:  Point to a transition in the Transitions  gallery to see an instant preview of the effect on your 

active slide. 

Animati ons Improved!  

Animating slide content adds a dynamic element to static slides and helps focus your audienceõs 

attention exactly where you want it to be. PowerPoint 2010 adds more realistic motion to your 

favorite animations and provides streamlined tools t o help you access, customize, and apply 

animations more easily. 

Tip : Trigger elements on the slide to animate when a bookmark is reached during playback of the audio 

or video content on your slide . After you add bookmarks in your media, access those bookmarks easily on 

the Animations  tab shown in Figure 10, under the Trigger  command. Just apply the animation you want 

to a selected object and then apply the bookmark trigger.  
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Figure 10: Access, preview and apply animation effects more easily in 

PowerPoint 2010. 

Animation Painter  New!  

You take the time to customize an animation sequence and get it exactly right for your 

presentation. Do you then have to start again when you need the same animation settings for 

other objects in your presentation? Not anymore.  

The new Animation Painter works very much like the popular Format Painter tool available in 

several Microsoft Office programs for copying the formatting of text and objects. After you 

spend the time to create custom animation for an object, you donõt have to do it again. Just 

select the object that contains the set of animations that you want to copy, click the Animation 

Painter button, and then click the object to which you want to apply the copied animation. Or, 

double-click Animation Painter to lock it in the on position and then apply selected animation to 

as many objects as you need, on other slides and even in other presentations. 

Tip : Find the Animation Painter on the Animations  tab in the Advanced Animation  group. Or, press 

ALT+SHIFT+C to copy the set of animation from the selected object and then just click the object to 

which you want to apply it.  
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Additional Office Themes  

Additional built -in themes in PowerPoint 2010 offer a broad range of layout and formatting 

options to help you create consistent, professional designs across your presentations and all of 

your Office 2010 documents.  

Just click to apply the theme you want and PowerPoint 2010 does the rest. Slide layouts, 

backgrounds, fonts, colors, and graphics formatting effects all update instantly  when you format  

your presentation using themes, helping to ensure that all elements in your presentation 

complement one another. And, when you create Office Art graphics in your presentation (such 

as SmartArt diagrams and Excel 2010 charts), the formatting automatically coordinates with your 

theme.  

Mix and match theme fonts, colors and graphic effects to quickly create your own theme. You 

can also create your own custom themes, such as to easily apply your personal or business 

branding. The same themes are available in Word 2010, Excel 2010, Outlook 2010, and Microsoft 

Access®  2010, making it easy for you to brand all of your Office 2010 documents. 

Tips:  

¶ Access 40 built-in themes from the Themes gallery on the Design  tab in PowerPoint 2010 and get 

easy access from that gallery to many more themes available on Office.com. Check the Office.com 

category in the Themes gallery oftenñselect themes appear automatically as they become available. 

¶ To quickly create a custom theme by mixing and matching theme elements, select separate theme 

colors, theme fonts, and theme formatting effects from their respective galleries on the Design tab, in 

the Themes group. Then, use the Save Current Theme  option at the bottom of the Themes gallery to 

save your selections as a custom theme. Once saved, your theme is automatically available to content 

in PowerPoint, Word, Excel, Outlook, and even Access 2010. 

¶ Use Live Preview to explore how different themes will look for your presentation. Just point to entries 

in the Themes gallery to see a preview on your slide. 

¶ See the Power User Tips section later in this guide for information on how to create your own 

completely custom theme. 
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Figure 11: 

Find the 

Themes 

gallery on 

the Design 

tab in 

PowerPoint. 

Additional SmartArt Graphics  Improved!  

You know that a graphic can often help display your important points more effectively than just 

text. Thatõs why itõs so important to choose the right type of graphic for your content and make 

it look its best. Fortunately, Office 2010 adds dozens of additional SmartArt layouts for a total of 

more than 130 different diagrams that you can create as easily as typing a bulleted list. 

These popular graphics, introduced in Office 2007, make it possible for anyone to create truly 

impressive diagrams. SmartArt layouts include a broad range of options from lists to process, 

cycle, and relationship diagrams to help you convey related ideas and non-linear concepts with 

greater visual impact. 

The new layouts added in Office 2010 include additional organization charts, picture diagrams, 

and many more. You also get improved tools for working with picture diagrams, such as the 

ability to easily add or replace images from within the text pane and to replace selected images 

in your diagram using the Change Picture Command on the Picture Tools Format tab. 
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Figure 12: The Choose a SmartArt Graphic dialog box, available on the Insert tab in the 

Illustrations group. 

Tips:  

¶ When you insert a SmartArt graphic, the SmartArt Tools Design  and Layout  tabs become available 

on the Ribbon. On the SmartArt Tools Design  tab, find galleries of formatting effect styles and color 

options that automatically coordinate with your theme. Also find the Layouts  gallery on that tab, from 

which you can select a different layout and just click to apply it to your selected diagram. Content 

youõve already added to your graphic automatically updates in the new layout. 

¶ When you insert large image files into small picture placeholders in SmartArt graphics, keep in mind 

that the resolution is likely to be higher than you need for a small displayed image. To save file size 

and make your SmartArt graphic easier to edit, compress the pictures you insert in your graphics. To 

do this, select a picture in the graphic and then, on the Picture Tools Format  tab, in the Adjust  

group, click Compress. 

¶ When you need to extract content from your SmartArt graphic, use the new Convert  tool  on the 

SmartArt Tools Design  tab to convert your SmartArt graphic to text or shapes. 

¶ Notice the new Office.com category in the SmartArt dialog box shown in Figure 12. Select SmartArt 

layouts hosted on Office.com appear automatically in that category as they become available. 

¶ Office 2010 developers can take advantage of a new object model for SmartArt graphics. 

Note : SmartArt graphics are also available in Word 2010, Excel 2010, and Outlook 2010. 
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Equations  New!  

PowerPoint 2010 makes it easy to create and display math equations on your slides. Select from 

several pre-created equation types to help you get startedñfrom simple formulas (such as 

╪ ╫ ╬) to more complex mathematical constructs as shown in Figure 13ñor create your 

own equation from scratch using a rich set of intuitive tools.  

 

Figure 13: Use the Equation Tools Design tab to quickly and easily build professional-

quality equations on your slides. 

Tip : To insert an equation, on the Insert  tab, in the Symbols  group, click Equation  to insert a blank 

equation and access the Equation Tools Design tab. Or, click the arrow below the Equation  button icon to 

select an equation from the gallery.  

If your insertion point is not in a placeholder or other text box when you insert an equation, PowerPoint 

inserts a new text box for you. 

Inking  Improved ! 

If you use an ink-enabled device, such as a Tablet PC or a Wacom tablet, PowerPoint 2010 gives 

you more flexibility when using ink to add content to your slides. Convert drawn shapes to 

Office Art shapes, save your favorite pen types for quick access, and use drawing tools that 

make it easier to position and manage ink objects. 
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Smart Guides  New!  

Quickly and precisely lay out shapes, images and media objects using new smart guides. As you 

drag applicable content types on a slide, guides appear automatically to show when alignment 

is precise. 

 

Figure 14: Drag 

shapes, images or 

media objects on a 

slide and 

automatically see 

the dotted, smart 

guides to show you 

when positioning is 

precise. 

Quick Tips:  Smart guides appear by default when media objects, images, custom text boxes, or shapes 

that you insert from the Shapes gallery are aligned. Smart guides are designed to help you more easily 

align content that you position on a slide , so they do not work with im ages or other content that appears 

in placeholders. 

Custom Shapes New!  

Expand your creative options when working with shapes. Custom shape actions enable you to 

combine, intersect, subtract, or join two or more selected shapes, as shown in Error! Reference 

source not found. . 

 

Figure 15: Two 

shapes shown at 

left and then after 

using the combine, 

intersect, subtract, 

and union 

commands. 
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Quick Tips:  To access custom shape actions, add them to your Ribbon or Quick Access Toolbar. To do 

this, click the File tab to open Backstage view and then click Options . On the Customize Ribbon  or 

Customize Quick Access Toolbar  tabs, select All Commands  from the Choose Commands From  list 

and then find Shape Combine , Shape Intersect , Shape Subtract , and Shape Union  commands. 

Design Advice  New!  

Looking for  guidance on how to create engaging presentations? Get creative advice from 

Academy Award®-winning Duarte Design in a template available from right within PowerPoint 

2010. To access this template, click the File tab to open Backstage view and then click New . 

Click Sample Templates  and then select Five Rules. 
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Get easier access to the right tools, at the right time  

Ribbon  Improved!  

Locate the commands you need when you want them and where you want them. The improved, 

customizable Ribbon, available in all Office 2010 applications, replaces traditional menus and 

toolbars to give you a more personalized work experience. Itõs designed to help you more easily 

find and use the full range of features that PowerPoint provid esñso that you can get more 

done in less time. 

¶ Create your own tabs or customize built -in tabs on the Ribbon to personalize the 

PowerPoint 2010 experience to your work style.  

¶ The standard tabs that you see on the Ribbon are organized to display commands 

relevant to a given task, so that you can find what you need more quickly.  

¶ The Ribbon also offers contextual tabs to give you exactly the tools you need, when you 

need them. For example, when you select a video, contextual tabs appear on the Ribbon 

to prov ide all the tools you need for working with that video  as shown in Figure 16. 

 

Figure 16: Contextual tools automatically display when you need them. 
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Microsoft Office Backstage View  New!  

On the left edge of the Ribbon you see the File tab. Just click that tab for an all-access pass that 

makes it easier than ever to manage your files and customize your PowerPoint experience. 

The new Backstage view replaces the traditional File menu to provide a single location for all of 

your file management tasks. For example: 

¶ When you first open Backstage view, youõre on the Info tab. From this one location, you 

can compress and optimize the media in your presentation, view and edit file properties, 

inspect the presentation for proprietary information you may not want to share, and 

much more. 

¶ From the Save & Send tab in Backstage view, you can create a video of your 

presentation, or send your presentation as a PowerPoint 2010 attachment, a PDF, or an 

XPS file. You can also save a copy of your presentation to other file types, such as the 

new PowerPoint Picture Presentation that creates a copy of your presentation with each 

slide as a picture. Or, save your presentation to an online location for access to new 

collaboration features discussed later in this guide. 

¶ The Print tab, shown in Figure 17, provides a new, integrated print experience with a full 

slide Print Preview right alongside all of the print options you need . 

 

Figure 17: The 

new integrated 

print 

environment 

available from 

Backstage view. 
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Quick Tip s:  

¶ Now itõs easy to print multiple pages of notes per slide. In Backstage view, on the Print  tab shown in 

Figure 17, click the option that defaults to Full Page Slides and then select Notes Pages. All slide 

notes print, regardless of the number of pages. 

¶ Check out the Recent tab in Backstage view for lists of both recently accessed files and recently 

accessed locations. Pin files or locations to that tab to keep them easily accessible. 

Save time and simplify your work  

Multi -Window Support  (SDI) New!  

PowerPoint 2010 delivers new flexibility when you need to work on multiple presentations at the 

same time. Now, each presentation that you open is in an entirely independent window as you 

see in Figure 18.  

Access options from Backstage view for one presentation while reviewing the slide show for 

another. With each presentation in a completely separate window, you can even display 

presentations on separate monitors when multiple  monitor s are connected to your computer.  

 

Figure 18: Control 

each open 

presentation 

independently 

with new multi -

window support.  

Quick Tip:  The multi -window support available in PowerPoint 2010 is also known as a Single Document 

Interface (SDI). 
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Presentation S ections  New!  

Because presentations can contain dozens of slides, organizing and managing them can become 

a challenge. In PowerPoint 2010, you can assign slides into logical groupings or sections for 

easier navigation and organization. Name sections to easily assign a set of slides to a team 

member or otherwise customize the organization of your slide sections. In addition, you can 

save time by moving to slides by section while in your slide show or by printing your slides by 

section. 

 

Figure 19: Organize and manage slides more easily using new presentation sections. 
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Recover Unsaved Versions  New!  

Weõve all done it. You work for a while, get the content just right, and then close the 

presentation without saving. Maybe you thought the save prompt was for a different file that 

you didnõt want or maybe you were just distracted while closing the file. The result is the sameñ

your work and the time you spent to create it have been lost. Well, not anymore!  

Expanding on the AutoRecover capabilities that you may know from earlier versions of Microsoft 

Office, Office 2010 now recovers files that you close without saving.7 Easily access and manage 

recovered presentations right from the Info tab in Backstage view, as shown here.  

 

Figure 20: Access recovered versions of your presentations on the Info tab in 

Backstage view, under the Versions heading. 

                                                 

7
 Recovering available unsaved documents and autosave versions requires you elect to save AutoRecover information.  To keep an 

autosave version until your next editing session you must also elect to keep the last autosaved version when you close without 

saving. To access these options, in Backstage view click Options and then click Save. 
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¶ You can recover drafts of presentations that were never saved. Find this option in 

Backstage view, on the Info tab, under the Manage Versions button. 

¶ Also access up to the last five autosave versions of your previously saved active 

presentation from the Info tab in Backstage view. By default, the last autosave version 

remains available temporarily if you close the presentation without saving. 

Quick Tip s:  

¶ Need to quickly access other content in the folder where your active document is stored? In 

Backstage view, on the Info  tab, just click Open File Location . Find this option under the heading 

Related Documents  in the Properties  pane shown in Figure 20.  

¶ Get more information about recovered versions in the Power User Tips section of this guide. 

Paste with Live Preview  New!  

Save time when reusing content within PowerPoint 2010 or across applications. Paste with Live 

Preview enables you to preview various Paste Options, such as Keep Source Formatting or Keep 

Text only, so you can see how your pasted content will look prior to actually pasting. Instead of 

using Undo and trying again, Paste with Live Preview helps you get it right the first time.  

 

Figure 21: 

Simply point 

to a paste 

option to 

preview 

results and 

then click to 

select the 

option you 

prefer. 
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Quick  Tip:  You can still access paste options after you paste without having to undo any actions. Click the 

icon that appears alongside pasted content to expand Paste Options . Or, if you prefer to use the 

keyboard, press CTRL to expand Paste Options and then use left and right arrow keys to move through 

the options. If you select a different option from your first choice, the result is automatically replaced.  

Note : Paste with Live Preview is also available in Word 2010, Excel 2010, Outlook 2010, and for 

text in Publisher 2010. 

Reading V iew  New!  

When reviewing a presentation, you might need to look at another presentation or access other 

programs. PowerPoint 2010 saves you the trouble of shuffling back and forth between files with 

the new Reading View. This view enables you to view your presentation as a slide show with full 

animation effects and multimedia, but within a window that leaves you easy access to your other 

presentations and programs via the Windows taskbar. 

 

Figure 22: Use the new Reading View to retain easy access to other 

programs and files while reviewing your presentation in slide show mode. 
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Quick Tip:  When in Reading View, the Status bar is visible at the bottom of the PowerPoint window. Use 

the options on the right side of th e status bar to access the Slide Show menu, move between slides, or 

select a different view. 

OneNote Linked Notes  New!  

You do research and gather content while working on presentations. But, how do you keep all of 

the pieces connected and find the information you need when you need it?  

OneNote 2010 makes it easy by creating links not just to the presentation youõre working on 

while you take notes, but to the exact slide you were working on when you took a given note. 

Dock OneNote on the side of your  desktop and take notes while you work on your PowerPoint 

2010 presentation. As you see in Figure 23, OneNote adds an icon in the margin beside your 

notes. Just click that icon when reviewing your notes later to open the source file and jump 

straight to the information you need.  

 

Figure 23: The 

OneNote Linked 

Notes feature adds 

an icon in the 

margin of each 

paragraph as you 

take notes, 

indicating the 

source program 

and providing a 

link to your 

location in the 

source file. 

Quick Tip:  To take Linked Notes while working in PowerPoint, start with a previously-saved presentation 

in the PowerPoint 2010 file format and take your notes in a OneNote 2010 notebook. 

Note : This OneNote 2010 feature is also available when working on Word 2010 documents or 

when browsing the Web using Windows®  Internet Explorer®  6 or later.  
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Redefine working together on presentations  

Broadcast Slide Show  New!  

Faster than arranging a Web meeting, easier than getting everyone in the same roomñnow you 

broadcast your slide show live to a remote audience with just a few clicks.8 Everyone you invite 

to your presentation can view the show in high -fidelity and in real-time from their Web browser, 

whether or not they have PowerPoint installed. 

Broadcast Slide Show creates a URL that you can share with others by e-mail or instant message. 

When someone clicks the link, they see your slide show broadcast via the new PowerPoint Web 

App introduced later in this guide.  

 

Figure 24: When you 

present using the new 

Broadcast Slide Show 

feature, viewers watch 

your slide show in real-

time, from their Web 

browser. 

Quick Tip:  If your company uses Microsoft SharePoint
®

 Foundation 2010 and has Office Web Apps 

installed, you can broadcast your slide show within your firewall. Otherwise, PowerPoint 2010 uses 

Windows LiveË as the default broadcasting service. Broadcasting via Windows Live is a free service that 

enables up to 50 attendees per broadcast. 

                                                 

8
 Requires SharePoint Foundation 2010 for business or a free Windows Live ID for personal use. To broadcast via SharePoint 2010, 

Office Web Apps must be installed. 
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Create a Video  New!  

PowerPoint 2010 makes it easy to share your presentation with those who missed the live 

eventñor to create a presentation video for any purpose, such as recording your own video 

training course or publishing your presentation on a video-hosting Web site. It takes just a few 

clicks to create a video of your presentation, complete with your saved narration, slide and 

animation timings, and even your laser pointer movements. PowerPoint builds the video for you 

while you work, so you donõt lose a minute.  

 

Figure 25: Easily create a high-fidelity video of your presentation.  

Tip : The Record Slide Show feature that you can use to include timings and narration in your presentation 

video is improved in PowerPoint 2010. In addition to slide and animation timings and narration, you can 

now include a new laser pointer tool in your reco rdings.  

To show the laser pointer during your slide show, press and hold the CTRL key on your keyboard and 

press the left mouse button.  
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Co -Authoring  New!  

Save time, simplify tasks, and improve your teamwork. Co-authoring capabilities in PowerPoint 

2010 enable you to simultaneously edit the same presentation with colleagues or friends.9 

Automatically see who else is editing and on which slide theyõre working. You can even initiate a 

conversation with other editors instantly, right from PowerPoint 2010. 10 

 

Figure 26: Clearly see where another editor is working in the same presentation, 

quickly access their contact information, and connect with them without leaving 

PowerPoint.  

¶ Just save the presentation to see changes from other editors as you work. Your changes 

also become available to other editors each time you save. 

                                                 

9
 Co-authoring requires SharePoint Foundation 2010 for business use or a Windows Live ID for personal use. Co-authoring via 

Windows Live will become available in the second half of calendar year 2010. 

10
 Instant messaging requires one of the following: Microsoft Office Communications Server 2007 R2 with Microsoft Office 

Communicator 2007 R2; Windows Live Messenger, or another instant messaging application that supports IMessenger. Voice calls 

require Office Communications Server 2007 R2 with Office Communicator 2007 R2 or an instant messaging application that supports 

IMessengerAdvanced. 




























































































